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Pre-requisites 
You should have a certain number of skills already if you are going to progress further with any 

word processing program. You must know:  

 

a) How to start a program (Beginners 101), 

b) How to open and save a file (Beginners 102),  

c) How to move around the text in a document (Beginners 103), and  

d) How to make changes (edit) to text (Beginners 103). 

e) How to access and navigate around a website (Internet 105) 

 

Personal Websites and Content 
Marketing – Ideal for Real Estate Agents 
 

Get all the tools you need to create, maintain, optimise and promote your website to new 

and existing clients. Includes:  

 

1. Website with a sales and information focus – landing pages and call to action 

2. Automated Response Marketing System 

3. Build Credibility with a database of subscribers, automate your marketing and stand out 

from others around you (ideal for Real Estate Agents) 

4. Get discovered by Google for vendors looking for a good local agent 

5. Analytics and Training about how to use this information and tweak your website. 

6. Included website hosting management and security. 

 

Visit www.123ezy.com for more information. 

 

VoIP Telephone System and CloudPBX  
 

Get all the features of a business telephone system AND the 

benefits and cheap calling rates of VoIP. Includes:  

 

1. Telephone Extensions (can be anywhere in the world, including home office) yet still part of 

the phone system. 

2. Calls from extension to extension are free, no matter where they are located. 

3. Unlimited local and national calls 

4. Take your phone number with you if you move and transfer calls between extensions 

5. Voicemail system built in 

 

Visit www.virion.com.au for more information. 

 

A Training System for your own staff and 
or contractors 
 

We’ve been creating training courses, workbooks, videos and tests and managing thousands of 

enrolments per year for ourselves and other training organizations and we can do it for you.  

 

1. Staff and Contractor Compliance 

2. Contract your training to us 

3. Monthly cost or contract services 

4. Enrolments, Assessments and issuing Certificates

http://www.123ezy.com/
http://www.virion.com.au/
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The Word Screen 
 

 
 

There are a lot of things to look at on the Word screen. There are buttons, rulers, scroll bars, task 

bar, toolbars and lots more.  

 

Exercise: Get to know the Word screen. 
Below is a list of some things to notice on the screen. Put the corresponding number against each of 

them in the diagram above. 
 

1 – Title Bar 7 – Ruler  

2 – Menu Ribbon 8 – File name  

3 – Minimise Word button 9 – Toolbars  

4 – Maximise Word button 10 – Page indicator  

5 – Close Word button 11 – Text  

6 – Status Bar  12 – Selection Bar  

 

Exercise: Differences to what is on your screen 
Write down as many things that you can notice different between the diagram above (Word Version 

2013) and what you see on your Word screen. 

 ...............................................................................................................................................  

 ...............................................................................................................................................  

 ...............................................................................................................................................  

 ...............................................................................................................................................  
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The Menu System 

Ribbons 

 

 
Figure 1 Office 2013 Home Ribbon 

 

Microsoft Office programs now come with a ribbon menu system. You can click on each of the 

words at the top of the screen to reveal a ribbon of menu options beneath. If you move your mouse 

over a button (and keep the mouse still) you will see that the computer tells you what that button 

does. 

 

 

Ribbon Sections 

Each ribbon is divided into sections. Eg. The 

Home Ribbon contains Clipboard, Font, 

Paragraph, Styles etc. You can click on the 

small Expand button to the right of each of 

these options to see more detailed information 

about that Section. 

 

 
Figure 2 Ribbon section, Font Expand 

 

When you click on the Font section expand 

button, you see a dialog just like in previous 

versions of Microsoft Office applications. 

 

Extra Menus 

When an image or a table is selected an extra 

ribbon menu appears; 

 

 
 

This image above shows what the ribbon menu 

system looks like when an image within a table 

is selected. Two extra menus appear. 

 
 

Figure 3 Font properties dialog box 
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Quick Commands 

For common commands like Save, Print Preview and Print there is a Quick Access toolbar at the 

top in the title bar. You can click the drop down arrow at the right to reveal your choices and then 

click which ones you want to appear permanently (This is called Customising your Quick Access 

Toolbar). 

 

 
 

Exercise: Customise The Quick Access Toolbar 
1. Make sure you can see the following buttons in the Quick Access toolbar 

 Print Preview and Print button, and 

 Spelling and Grammar button  

2. Click the Show Below the Ribbon option and notice where the Quick Access Toolbar goes 

3. Select the Print Preview and Print button from the drop-down menu, notice the icon for Print 

Preview and Print is now added to the toolbar. 

4. Next, select the Spelling and Grammar button. 

 

Exercise: Turn Show options on/off using View menu 
1. Click on the View ribbon and notice the Show options 

 

 
 

2. Putting a tick in the box next to Ruler, Gridlines and Navigation Pane will show these items. 

3. Check all three boxes. Notice that as you check the box that option will show on the screen. 

4. Now uncheck all Show options to turn these items off. 
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Exercise: Collapse the ribbon 
1. Right-click anywhere on the tabs or ribbons. 

2. Select the option to ‘Collapse the Ribbon’. Notice the ribbon is minimized and you have 

more space to view your Word document. 

3. Right-click any of the tabs in the top of the page. 

4. Deselect Collapse the Ribbon. 

 

Default Settings 
When you first launch Word, a blank page appears on the screen. This page is based on what is 

called the Normal Template (templates are covered more later) and has a default paper size (eg. 

A4), a “default” text style and size and other default settings. When we say default it is not a bad 

thing. Imagine if you had 2 printers attached to your computer: One of them would be the default 

printer. This is the printer that is most often used. If you wanted to use the other printer you could 

choose it from the print dialog box. Default is like saying the “automatic choice”. 

Document Names 

When you create a New File, Word automatically calls it “Document 1” (or Document 2, 3, 4 

depending on how many new files you open). 
 

  The name of the File and Program is located in the title bar. 
 

Names are also shown in the Task Bar or when 

you hover your mouse over the Word icon. It is 

a good idea to save your work soon after you 

start typing and frequently thereafter just in 

case you lose power or something happens to 

your computer. 

 

Exercise: Document Names 
You should have Word running and a blank document on the screen. You should also see the word 

Document 1 in the title bar. 

 

1. Move your mouse to the left most ribbon tab and it should say File. Click New  Blank 

Document and now you have created a New Blank Document. This is the quick way to do it 

 

2. What does it say in the Title Bar? ……………………….. 

 

3. What is the name on the new button in the Task bar? …………………………. 

4. Click the File tab, New > Blank Document > Create button again 

 

5. What is the name of this file? …………………………… 

 

6. The button that looks like it is indented is the Active window. Look at the Title Bar and they 

will match. 

 

Exercise: Closing programs using Right-click 
1. Right-click on the button in the Taskbar that says Document 3 and from the shortcut menu 

that appears, click on Close Window. 

2. Repeat step 1 with the button that says Document 2. 
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Opening Files 
If you have completed the Beginners Series, you’d know that there are several ways to activate the 

Open command e.g.:  

 

a) Click on File, then choose Open from the menu list 

 

b) Use the Keyboard shortcut (Ctrl + O) 

 

 
 

 

Keyboard Shortcuts 

For many commands in Microsoft Word 

that you will use regularly there are 

keyboard shortcuts, like Ctrl+S. This 

means press and hold the Control button 

down and while it is down, press and 

release “s”, then take your finger off the 

Control button. Doing this will Save your 

file.   

 

 

  

 

 

Recently used file list 

 
 

  

 At the bottom of the File menu 

list is a Recent option, these are 

the most recently used files.  

 Number 1 is the most recent, 

number 9 is the 9
th

 last file used 

(and you can increase this to 

many more recent files).  

 They are listed in the order by 

which you most recently opened 

them.    

 There is a pushpin next to 

each recent item.     

 Selecting a pushpin will pin it to 

your recent list so it doesn’t 

disappear as you work with more 

and more documents 
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Exercise Files 

Exercise files are included with most of our courses to provide you with documents have already 

been created that you can look through to see how the Word tools are used. The exercise files are 

also included to give you a file to practice on without having to create one from scratch.  

 

In this course we’ve included a document that shows you various Word tools that you will learn 

when you go through all of our Microsoft Word courses (Beginners, Intermediate and Advanced). 

 

Where are files stored 
You can access the Microsoft Word Beginners course 201 exercise files at our Learning 

Management System or from the site where we offer our free Microsoft Word Beginners Course 

demonstrations.  

 

When you open these files they may be stored in your Temporary Files folder or Downloaded Files 

folder so it is ALWAYS a good idea to save each file in a place you are familiar with – for most 

people that is the My Documents folder on their hard drive. 

 

Exercise Files Included: 
1. First exercise 

2. Risk Taking Is Free 

3. Content Marketing for 

Real Estate Agents  
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Exercise: Opening a file 
1. create a folder on your computer called EzyLearn Word Course 201 

2. Download each exercise file and save it into your exercise files folder. 

3. You should have Word running, click on File, then click Open 

4. Click on the Look in: drop down arrow and navigate to your EzyLearn Word Course 

201 folder 
5. Double-click the first exercise file.     

 

 
 

 

 

This is an example of what it 

would look like after you have 

double-clicked on W1 

- click on the Open button 

again and then the drop 

down arrow to see this 
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View Icons 

 

 
 

Click on the View ribbon to see the Document Views icons to see what they do.  

 Print Layout view is the one we prefer working in.  

 Web Layout view is what your document would look like if you published it on the 

Internet.  

 Outline view shows the structure of the headings in relation to each other. That’s covered 

more in Styles (Level 3). 

 Draft view allows a view to quickly edit text.  

 
 

 

 These buttons can also be found at 

the bottom-right of the Word screen.  Here you can quickly the icons to change to a different view. 

 

Zoom 

 

 
 

The Zoom slider is on the bottom right of your Word document. You can see the Zoom percentage 

to the left of the slider.   You can click the slider button in the middle to Zoom in/out or press the 

plus/minus icons.    You also have a few more Zoom options from the View tab of the Word 

ribbon.. 

 

Zoom only effects how close you look at your document. It has nothing to do with how large the 

document will be when you print it. Consider it like a magnifying glass.
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Exercise: Change between views 
1. Click on the View ribbon (menu bar), what is the current view? 

2. Click on Draft. Notice that you can no longer see the edge of the white page 

3. Click on the Print Layout icon (bottom left). 

 

Exercise: Using Zoom  
1. Open the file first exercise (if not already open) and click on the zoom slider. 

2. Click the plus sign until you to get to 150%  

Notice that you are much closer to the text. You now have to scroll to get to the left or right 

or up and down. This does not mean that the text is bigger when you actually print it 

3. Click on the minus sign to get to 50% Zoom  
Notice this time it is like pushing the page further away from you so that you can get a 

better perspective of what it looks like 

4. Click on the Zoom percentage and in the window that opens, under Percentage type the 

number 83 and press Enter (keyboard). Notice that you can get exactly the zoom you 

want. 

5. Click the Zoom percentage and from the window that opens, select Text Width 

This is the largest you’ll be able to see all your text on the screen without having to scroll 

left and right 

6. Click on the zoom drop down arrow and click on Page Width 

This will give you the best idea of how your document will look when it is printed because 

you can see how large the margins are and where the text stops compared to the end of the 

page. 
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Moving around your document using the keyboard 
There are several ways to move around a document. Most of us know about the mouse and scroll 

bars but there are some other ways of using the keyboard. 

 

Which Keys to use Result 

 &  Moves one character at a time 

 &  Moves one row at a time 

Ctrl + Home Beginning of a document 

Ctrl + End End of the document 

F5, Ctrl + G, or  

Edit(menu bar), Go To 
Brings up the Find and Replace dialog box 

PageDown Top of the next screen 

Page Up Top of the previous screen 

Home Beginning of a line 

End End of a line 

Ctrl + , Ctrl +  Right or left one word 

Ctrl + , Ctrl +  Up or down one paragraph 

Ctrl + PgUp, Ctrl + PgDn Up or down one page (top of page) 

 

SPECIAL NOTE:  

Remember when you see Ctrl + , the + means that you keep your Ctrl key pressed down while 

you press and release the second button. The other example we used earlier was  

Ctrl + O as a quick way to activate the Open command. 

 

Find and Replace dialog box 
 

 
 

 

Notice that many of the options we talk about 

in this page activate the Find and Replace 

dialog box, but take you to different tabs.  
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Exercise: Using the keyboard to move around text 
1. Open the file first exercise if it is not already open 

2. Move to the end of the document by pressing Ctrl+End 

3. Move to the beginning of the document by pressing Ctrl+Home 

4. Move to the 3
rd

 page by pressing Ctrl+PgDn two times 

5. Move back to page 2 by pressing Ctrl+PgUp 

6. Move to the title “Microsoft Excel” in the current page by pressing Ctrl+ as many times as 

you need to 

7. Move to the end of the current line, by pressing the End key 

8. Move back to the beginning of the line by pressing Home 

9. Move to the beginning of the word Excel by pressing Ctrl+ 

10. Move to the beginning of the document by pressing PgUp several times 

11. Press the  key 5 times 

12. Press the Home key to get back to the beginning of the line 

13. Keep the first exercise file open for the next exercise. Well done. 

 

TASK: More Advanced find 
1. Use the Find command to see how many times the word “Microsoft” appears in the 

document “first exercise” 

 
 

2. Replace the word Microsoft with MS 

3. Cancel the find & replace box and use the double arrows above and below the browse 

objects button to look at each occurrence of the word MS. 
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Selecting (or highlighting) Text 
Now that you know how to move around a document we will cover selecting text. You need to 

select text if you want to: 

1. make changes to it 
2. move it somewhere or  

3. change the way it looks (formatting).  

Like most things on the computer, you can select text using your keyboard and/or your mouse. 

Using the Mouse 

It is important to know that there is a selection bar in Word that can be used (and is often used by 

mistake) when highlighting text. It is the area in the document to the left of the left margin (we 

pointed it out when we had a look at the different parts of the screen). 
 

Mouse Action Result 

Double click on a word Highlights that word 

Triple click on a word Highlights that paragraph 

Click and Drag along selected words. Highlights the words chosen 

Ctrl + Click Highlights that sentence 

Click at the beginning of a block of text 

and press shift (hold it down) and then 

click at the end of the block of text. 

Highlights from where you clicked first to 

where you clicked last. 

Click on Edit, Select All Highlights all the text in the document 

Click in the selection bar Highlights the text in one line 

Double click in the selection bar Highlights that paragraph 

Triple click in the selection bar Highlights all text in the document 

 

 After highlighting, click anywhere in the document and the highlighting will go away. 

Using the Keyboard 

Here are some keyboard shortcuts you can use to highlight text if you want to. 
 

Which Keys to use Result 

Shift +  or  Highlights one character to the left or right 

Shift +  or  Highlights one line down or up 

Ctrl + Shift +  or  One word to the right or left  

Shift + End From text cursor to the end of the line 

Shift + Home From text cursor to beginning of the line 

Ctrl + Shift +  or  Selects a paragraph up or down 

Ctrl + Shift + Home Selects to beginning of document 

Ctrl + Shift + End Selects to end of document 

Ctrl + A Selects entire document 

 

 If text is highlighted and you start typing, the highlighted text will disappear. The easiest way to 

fix the problem is to use UNDO on the standard toolbar.
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Exercise: Highlight text using mouse + keyboard 
You should have the first exercise file on the screen. Notice that when your mouse is over text it 

becomes an I-beam. 

1. Double-click the word “Computer” to select it 

2. Click on any text that is not highlighted and notice that the word computer is no longer 

highlighted 

3. Move your mouse cursor at the beginning of the word “installed” and click and drag your 

mouse over the words “installed on your computer” 

4. Click in an area where no text is highlighted to un-highlight the text and this time move 

your mouse to the middle of the word “installed” and click and drag to the middle of the 

word “computer”. Notice that the same text was highlighted? 

5. Click in any other line of that paragraph 

6. Press the Ctrl key and hold it down and then click on the word “record” (halfway down 

the paragraph). Notice that the entire “sentence” was highlighted 

7. Click in a blank part of the screen to un-highlight the text 

8. Press Ctrl + A and all the text in your entire document are highlighted. 

 

Exercise: Highlight text using the selection bar 
Notice that if you move your mouse to the left of the left margin your mouse cursor changes to an 

arrow pointing in. 

1. Move your mouse (in the selection bar) to the left of the word Software in the first large 

paragraph and click once. What does it do?................................................... 

2. Double-click (in the selection bar) and the entire paragraph will highlight 

3. Click and drag (in the selection bar) to select more than one paragraph 

4. Triple-click (in the selection bar) and the entire document will be selected 

5. Click anywhere to un-highlight the text. 

 

Exercise: Highlighting text using the shift key 
1. Click your text cursor to the left of the heading “Where do you get software” 

2. Press and Hold the Shift key down and while it is down press and release the End key 

This will highlight to the end of that line 

3. Press the down arrow twice to get to the beginning of the paragraph beneath this heading. 

You may need to press the Home key to get to the beginning of the line 

4. Press and hold the shift key and press and release the right-arrow key 7 times 

Notice that this highlights one character at a time? 

5. Press the right-arrow key and no more text is highlighted 

6. Press Ctrl +  to move to the right one word at a time. Get to the beginning of the word 

“local” 

7. Press and hold the Ctrl and Shift Key down and while they are down press the  key 

three times 
Notice that it highlights one word at a time? You should have three words highlighted. 

Highlighting text always depends on where your text cursor is. 

 

Exercise: Drag & Drop 
1. In the file “first exercise” double click the word Computer (in the heading) 

2. Move your mouse to the middle of the word (notice your mouse is an arrow?) 

3. Click and Drag (while your mouse is an arrow) until your mouse is between the words 

Software & Packages. You will see a small vertical line when you are between the words. 

Release the mouse 

4. See how you moved the word Computer. That’s drag and drop. 
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Editing Text 

Deleting Text 

There are two keys that take text away. Delete and Backspace. There are some other methods: 
 

Action Result 

Ctrl + Backspace Deletes the word to the left of your text cursor 

Ctrl + Delete Deletes the word to the right of your text cursor 

Highlight some text and press Delete Deletes the text you have highlighted 

Inserting Text 

If you want to add some text between two words all you have to do is  

a) position your text cursor in between the two words and  

b) start typing what you want to type.  

The text to the right will automatically be pushed along (unless the Insert button has been turned 

on). Don’t forget to press the Space Bar when spaces are needed. 

Overtyping Text 

When the word processor is in Overtype mode, existing text will be replaced as you type, rather 

than be pushed along to the right. 
 

To turn this feature on, first ensure that it is displayed on the status bar. This can be done by right 

clicking on the status bar and pressing Overtype on the menu that appears. When this is done, there 

should be tick next to Overtype and the status bar should show Insert. To turn it on, click on Insert 

and it should now read Overtype. Insert is a toggle switch, it is now turned on, press it again and the 

feature is turned off. Always make sure that it is turned off when you have finished with it. 
 

You will see these following symbols in the status bar. 

 Overtype is turned off     Overtype is turned on 

 

Exercise: Editing text 
1. Open (click File in the menu bar) the file called first exercise if not already opened 

2. Look at the first line in the third paragraph (which starts with, Software programs are 

installed…) and you’ll see the word “computer” 

3. Move your text cursor to the beginning of the word computer 

4. Press the delete key until the word computer is deleted and type in PC 

5. In the fifth paragraph (which starts “You can buy it from…) you’ll see the words a box. 

Highlight these words using click and drag and replace it with the words retail packaging. 

(After the text is highlighted you can simply start typing) 

6. Move your text cursor (not just your mouse cursor) to the blank line above the heading 

The End and press Enter 

7. Type the following sentence: 
 

A popular web site for downloading software programs is www.download.com This is 

a web site where you can search for programs and download them to trial for free. 
 

8. Press Enter one more time so that you have a line beneath it. 

 

Exercise: Deleting a line 
1. Position your text cursor in the blank line between the heading “Where you get software” 

and the paragraph beneath it and press the delete key (keyboard). This deletes the Enter in 

that line and you don’t have a gap between the heading and the paragraph now 

2. Close the file; do not save the changes and leave Word running. 
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Non Printing Characters / Show Hide Button 

 
 

There are some keys on the keyboard that will put a character in your Word document but it won’t 

print out. The most obvious examples of this are: Space Bar, Enter Key, and Tab Key. 

Less obvious commands include Page Breaks and Section Breaks and Picture Anchors. 
 
 

 

The Show/Hide button is turned on in 

this diagram and you can see where 

the space bar, enter and tab keys have 

been pressed in the document. IF the 

Show/Hide button was off, you 

wouldn’t see anything after the actual 

text. 
 

Many people press Enter to go all the 

way to the bottom of the page when 

they first use a Word Processor. They 

want to see what happens. After they have done this, they move back up to the top of the page using 

the  

a) arrow keys or  

b) mouse wheel or 

c) scroll bar and then 

start typing their letter. What they don’t realise is that although they can’t see the “Enters” they 

have placed on the page, the computer thinks that they need to be printed. This is the biggest cause 

of a second blank piece of paper printing at the end of a document. The “Enters” end up making the 

document go onto page of the 2. Remember that each non-printing characters is just like any other 

letter or number; it can be created as well as deleted.  

 

Exercise: Non-printing characters 
1. Open the file called Risk Taking is Free 

2. Go to the end of the document by pressing Ctrl + End 

3. Press the Enter key 15 times, What happened? ……………………………………. 

4. How many pages are there in this document now? (Look at the status bar)……….. 

5. Press the Tab key 5 times and the space bar 10 times 

6. Click the Show/Hide button and notice what happens 

7. Press the Backspace key until you only have one page 

8. Close the file, Don’t save changes, but leave Word running 

Highlighting carriage returns 

Remember, when you highlight a paragraph of text, you highlighted the carriage return (the enter at 

the end of the line). 

Keys which do not put a character on the screen 

These keys move you around text which you have already put on the screen. They do not alter what 

you have typed.  

- Arrow Keys, Home, End, Page Up, Page Down 

 

 

The Show/Hide button in the Standard Toolbar, when clicked, shows you all non-printing 

characters and formatting. 
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Task: Learning more about Microsoft Word Tools 
 

Open the file “Content Marketing 

for Real Estate Agents” and click on 

every area of text of image that has 

a description in green beneath it and 

see if you can see the ribbons 

change or various areas of a ribbon 

change to reflect the formatting 

used in that area. 

 

Here are some examples: 

1. Click an image to see the 

Image ribbon header appear 

2. Double-click in the header 

to see the header and footer 

options 

3. Click on a hyperlink and see 

what happens 

4. Delete the red text and make 

sure there is still a blank line 

where the red text was 

 
 

 

Work from home 
 

Are you a good writer and want to run your 

own business working from home writing for 

real estate agents in your area (or even 

around the country)? Contact our StartUp 

Academy and begin the journey to a 

worthwhile business with the freedom of 

working from home? 

 

Click here  

http://startupacademy.com.au/services/opportunities/wordpress-website-design-business/
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What next 
 

You now understand how to turn selected tools on and off, how to work with text to select 

(highlight), edit and delete characters (including Non-printing characters) and how to see the 

different characters that are entered using the keyboard, but not necessarily shown on your screen 

(show/hide button). 

 

Word 202 

The next logical step is to understand more about the formatting options that are available to you in 

Microsoft Word. You’ll learn how to work with the Spell Checker, how to apply font formatting, 

and use keyboard shortcuts to perform your tasks much quicker and look very knowledgeable in 

front of your peers.  

 

You’ll also learn that there are several ways to get the job done, toolbars, menu bar options, 

keyboard “shortcut” options, right-clicking and other options.  

 

You’ll learn about Cut, Copy and Paste, and more advanced examples of these features like Collect 

and Paste and how to change your page printing options. 

 

Excel 301 

If you want to learn about two of the most popular Microsoft “Desktop” application programs at the 

same time, you may want to take a look at Excel basics. There are many similarities between the 

software programs but they perform completely separate tasks. 

 

Excel 301 is the first of several courses in Microsoft Excel, the spreadsheet program from 

Microsoft. 
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Word Shortcut Index 

Key Result 

CTRL+SHIFT+A Converts the selected text to all capital letters or all lower-case letters 

CTRL+SHIFT+F Displays the Font dialog box 

CTRL+SHIFT+G Displays the Word Count dialog box 

CTRL+SHIFT+S Displays the Apply Styles task pane 

ALT+R Displays the Review tab 

ALT+CTRL+1 Apply Heading 1, also ALT + CTRL + 2 will apply heading 2 

CTRL+SHIFT+L Applies Bullets 

CTRL+SHIFT+F5 Bookmark 

CTRL + B Bold Text 

CTRL + I Italic Text 

CTRL + U Underline Text 

CTRL+PAGE DOWN Browse Next 

CTRL+E Navigate to the center Paragraph 

CTRL+SHIFT+ENTER Column Break 

CTRL+SHIFT+C Copy Format 

ALT+CTRL+S Splits the Document 

CTRL+END End of Document 

END End of line 

CTRL+SHIFT+P Font size select 

SHIFT+F5 or ALT+CTRL+Z Go Back to previous state 

CTRL+SHIFT+. Increase Font 

CTRL+] Increase Font one point 

CTRL+[ Decrease Font one point 

ALT+SHIFT+R Header Footer Link 

CTRL+K Hyperlink 

CTRL+M Indentation 

CTRL+J Justifies Paragraph 

ALT+F8 Inserts Macros 

ALT+SHIFT+K Mail Merge Check 

F10 Menu Mode 

CTRL+H Replace 

CTRL+P Print 

ALT+SHIFT+BACKSPACE Redo 

F12 Save As 

CTRL+SHIFT+K Small Caps 

CTRL+SHIFT+S Style 

SHIFT+F7 Thesaurus 

ALT+SHIFT+T Time Field 

CTRL+SHIFT+M Unindent 

 


